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You and your employees are likely some of the 1.2 billion 
people worldwide who have used Microsoft Office. 
You're familiar with the standard apps such as Word, 
Excel, Outlook and PowerPoint, and you may have even 
explored the cloud offerings behind the collective set of 
leading productivity apps that make up Office 365. 

But there's more to Office 365 than meets the eye. 
From business intelligence programs to communication 
and collaboration tools and storage options for every 
member of your organisation, a shift to cloud-based 
Office 365 can mean a lot for your growing business.

In this eBook, you'll learn how you can best make use 
of specific Office 365 apps across six critical areas 
of your growing business: mobility, collaboration, 
communication, security, productivity and insights.

Introduction
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Mobility 
breaks down 
business walls

Chapter 1
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As a business leader, you need to be available 
when your team needs you, and vice versa. 
Mobility gives you and your employees the ability 
to get work done when you are away from the 
office, your desk or even your computer.

Your Office 365 subscription includes premium 
versions of the Word, Excel and PowerPoint 
mobile apps. Your workers will be able to 
perform the same way they would in the office 
– productively and effectively – in a familiar user 
interface that's optimised for their Android or iOS 
phone or tablet.
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How to add a 
comment in Word via 
your Android device 
or iPhone
If you're on your way to a meeting but need to give 
some feedback to a colleague while commuting, you 
can use the Word mobile app to edit a Microsoft Word 
document sent to you via email directly from your 
phone.

To add a comment:
Tap anywhere in a document, then click "Edit" and tap 
a word or anything else in the document.

Type your comment. If you're adding a comment for the 
first time, you'll be asked to enter a username so that 
other people will know who edited the document.
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Think that Excel is a desktop-only program? Think again. 
Your employees can do just about everything in Excel 
directly from their smartphone or tablet.

1. Formulas. Your employees can calculate formulas 
using their mobile app by tapping the "Formulas" tab.

2. Easily access your files. They can save an Excel file 
to OneDrive and access it quickly and easily on their 
mobile device.

3. Built-in keyboard. Their tablet's on-screen keyboard 
has common functions built in, so they can add 
formulas with ease.

4. Recommended charts. Excel's Recommended Charts 
feature is perfect for smaller screens, enabling users to  
quickly visualise data with a few taps of a finger.

Three Excel shortcuts 
that your workforce 
will love
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Prepare and present on the go.
Need to fix something on the way to a presentation? Use 
the PowerPoint app to make those changes from your 
smartphone or tablet.

The perks of going 
mobile with PowerPoint

Notes at your fingertips. 
Read your presentation notes 
directly on your phone.

Cut the cables.
Without needing bulky cables 
and wires, you'll be able to 
quickly get your presentation 
up and running. The Presenter 
View gives you full control 
over what your audience sees 
and only displays speaker 
notes on your tablet. New ink, 
laser pointer and highlighting 
features also let you emphasise 
key concepts as you present.
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Know your talking points. 
Ink your notes in order to help 
emphasise key points.
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Save files to the cloud on OneDrive for Business or SharePoint, then 
send everyone a single link to the same file, along with viewing 
and editing permissions. Everyone in your team will have the latest 
version of the file, eliminating version control hassles.

Mobility breaks down business walls

Sharing's never 
been easier
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Use Skype's "Chat" feature while the team works on 
a shared document:

• Click the "Chat" button to begin chatting over 
Skype with everyone working on the document.

Skype and collaborate 
with colleagues on a 
document in real time

Mobility breaks down business walls

• Even if you exit the Office document, you'll be able 
to continue the conversation via Skype on your 
desktop or mobile device, so you can keep talking to 
the team as they make edits.
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"We hear from millennials that 
flexible working is a high priority. 
And we believe that when you 
respect individuals for who they 
are and how they operate, it 
increases productivity significantly. 
By giving employees Office 365 
cloud-based components, we're 
able to create a more fluid, 
flexible approach to the physical 
workplace."

Carl Dawson 
IT Director, Marks & Spencer
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Collaboration 
drives business 
success

Chapter 2
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Your employees can outperform in their roles 
when they can work together as a team. As 
a business leader, you want to make it easy 
using technologies that are proven to work.

Office 365's apps can enable your teams to 
collaborate from start to finish. Employees can 
share meeting notes, co-author documents 
in real time, get updates and access files, so 
nobody ever misses a beat.
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Collaboration is a key component of Word 2016, and the 
real-time co-authoring feature gives team members the 
chance to easily share ideas and give direct comments 
in the doc.

Tips for co-authoring 
in Word

Get up and running.
To get started using real-time co-authoring, 
save your Word 2016 document to OneDrive 
for Business *. Next, click the "Share" button, 
located in the upper right of the window.

Invite colleagues.
Using the Share pane, invite others using 
their email addresses. They'll receive an email 
invitation to edit or view the document.

Enable real-time co-authoring.
Once they've signed on, you'll see a notification 
in the top-right of your screen. Clicking "Yes" 
will enable sharing changes and allow everyone 
to automatically see changes made in the 
document.

Work together seamlessly.
With everyone in the same document, you and 
your team can draft, comment and edit your 
work in real time. Add or reply to comments 
right next to the text you're discussing, so your 
colleagues can follow the conversation.

Collaboration drives business success

*Co-authors must be using Office 2016 or Office 
Online
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With multiple team members editing spreadsheets 
in real time, the risk of someone accidentally 
making a mistake or deleting important data is real. 
Office 2016's improved version history lets you see and 
revert changes to ensure that nothing is lost.

See document history at a high level.
Open the History pane by clicking File > 
History. Quickly see when the file was created 
and when it was last modified at a glance.

See who contributed to a file.
All revisions are listed by date and show the 
names of people who made the revisions, 
so you can follow up with anyone regarding 
their changes.

See how files evolve over time.
Click on a version to open it and examine how it 
differs from later versions of the same file.

Restore previous versions.
If you want to revert back to an older version 
that you find, simply select "Restore" and the 
document will be reverted back to the file as it 
was at that point in time.

Use history to 
collaborate with 
confidence
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Collaborate with PowerPoint in 
Office 2016.
New features improve the experience of 
working together on a presentation in real 
time with multiple team members.

Get team visibility.
The top-right corner of the screen shows 
you who's working on the file and where 
they're working. With one click, you can 
jump to the slides they're working on.

Initiate video chats.
By clicking on a person's thumbnail image 
and the Skype for Business logo, you can 
start a group chat to discuss the project 
you're collaborating on.

View document activity.
The activity feed shows you a full history of 
changes made to the document, letting you 
revert to prior versions if necessary.

Communicate through comments.
Threaded conversations and quick-access 
buttons let you quickly reply to or resolve 
comments.

Putting teamwork 
front and centre

Collaboration drives business success
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The days of digging around for files you want 
to attach to emails are now gone. With Outlook 
2016, sharing files is better with a new and 
seamless attachment experience.

Choose from recently accessed files.
When attaching a file to an email, all documents 
that you have recently accessed  on any of your 
devices will appear in a list – from your hard 
drive and from OneDrive, OneDrive for Business 
and SharePoint.

Grant permissions before sending.
Doc permissions can be viewed and/or changed 
when you're attaching a file 

Easily search for files from multiple 
locations.
With files in various locations, the attachment 
feature places them all at the same level. It's 
now easier than ever to search for files that 
you've previously attached from OneDrive, 
OneDrive for Business or SharePoint – you can 
search just as you would for any other file.

Now, with Skype for Business, you can 
simplify the communication experience by 
providing a tool that's both familiar and 
functional for calling, group conference 
calls, video and sharing.

1. Chat to all project collaborators at 
once.
Need to ask a quick question or clarify 
a point on a project? While working in 
Office Online, simply click on the Skype icon 
in the top-right corner of your screen to 
initiate a quick group call or video chat with 
one or more people.

2. Don't miss an opportunity to chat to 
a customer.
You can now invite customers or even 
prospects who are non-Skype users to join 
a meeting or webcast from their browsers 
or smartphones.

Collaboration drives business success

Two ways to 
communicate 
smarter in Skype 
for Business

New attachment 
feature tips
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1. Never overwrite an edit.
When a document has been "checked out", no other 
person can make edits to the document until it has been 
checked back in. To enable the "check out" feature for 
all documents, follow these instructions:

• Go to your document library.
• In the ribbon bar, click Library > Library Settings.
• Under General Settings, select Versioning Settings.
• Under Require Check Out, select "Yes".

2. Only reveal changes when you're ready.
When collaborating on a document, you don't have to 
share half-formulated ideas or edits. Your changes or 
those by another collaborator won't be released and 
viewable until the author saves them.

Two things that you 
probably didn't know 
about SharePoint
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During a meeting, several contributors can quickly capture their 
collective brainstorm ideas in a shared OneNote document at the same 
time. Need to follow up with someone on an idea? Edits are always 
attributed to a writer, making it easy to find out who wrote what.

1. Want to bring together your team in one 
virtual location?
With Yammer, you can create a group with the 
necessary project stakeholders and @mention team 
members in messages to communicate updates as 
needed.

3. Want to make better decisions based on 
knowledge across your organisation?
The Discovery feed and a smarter search feature 
help you stay on top of what matters most.

2. Want to make sure that your team is up to 
date all the time?
With Groups, all conversations, people and content 
are available in a single location.

Co-authoring 
features are perfect 
for brainstorming

Three Yammer tips for 
superior collaboration
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Communication 
empowers 
employees

Chapter 3
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An effective communications strategy is at 
the heart of successful collaboration. As 
a business leader, you want to empower your 
employees to initiate discussions and share 
ideas for optimal efficiency and success in 
their roles. Communications tools can do just 
that – and so much more.

From initiating a one-to-one dialogue 
or presenting ideas to a group to 
posting announcements to the entire 
company, Microsoft Office 365's suite of 
communications-centric tools gives your 
employees control over their conversations so 
that they feel connected wherever they are.
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Control your communications.
New features make it a single platform for 
every type of meeting, from instant one-to-one 
connections with colleagues to large virtual 
meetings of up to 250 people.

Get intuitive status control.
Want others to know when you're busy? 
With Outlook calendar integration, Skype 
for Business recognises when you're busy, 
automatically changing your status to "in 
a meeting" or "do not disturb".

Let attendees choose their view.
Meeting attendees can enjoy the freedom to 
pick from four views:

• Gallery View: Everyone's video streams

• Speaker View: The presenter's video stream

• Content View: Meeting content

• Compact View: All participants in a small 
window

Give and take back control.
Open up or close the floor for feedback and 
ideas with the "Give Control" and "Take Back 
Control" features. With the click of a button, 
presenters can select whether users can 
flip through content, contribute ideas or 
make changes to a whiteboard, OneNote or 
PowerPoint file.

Access from anywhere.
Public Switched Telephone Network (PSTN)* 
conferencing lets attendees dial into a meeting 
from a landline or with a single click on 
a computer or mobile device.

*PSTN Conferencing requires Skype for Business Online Plan 2, either as a standalone 
service or as part of an Office 365 Enterprise plan that includes the service (E1, E3 
and E5). PSTN conferencing is not available in all countries or regions.

Communication empowers employees

Skype for Business really 
puts the presenter in 
the driver's seat
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Six tips and tricks for using 
Groups

1. Bring your team together around a topic 
or project in just a few clicks.

2. Facilitate quick referencing and easy 
communication by accessing messages 
organised by thread.

3. Tag colleagues with the @mention feature 
when their input is needed.

4. Continue conversations on the go via 
Groups on the mobile app.

5. Initiate voice and video calls via the 
Skype for Business plug-in.

6. Access conversations offline for groups 
marked as "favourites".

The Groups feature elevates team communications by putting everything 
related to a project in one place. From Outlook, sets of users can connect, 
schedule meetings, share common calendars and files and take notes.

Connect and share 
from Outlook using 
Groups

Communication empowers employees
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1. Flickr images: Embed high-resolution photos from Flickr's 
vast database of imagery into your Sway storyline, complete 
with Creative Commons copyright information.

2. Before-and-after photos: Showcase a transformation 
by dragging a "comparison" card into your storyline. An 
interactive feature will let the viewer see the comparative 
images in a stunning visual display.

3. Maps, time-lapse videos or GIFs: Let an animation tell part 
of your story by selecting the "embed" card and pasting the 
original file's IFRAME code into your Sway.

4. PowerPoint presentations: Integrate a finished presentation 
by selecting the PowerPoint file in OneDrive and clicking 
"Embed". Then, copy the HTML code and paste it into 
your Sway. Select "Preview" to watch and interact with the 
presentation.

 

Communicate your 
ideas with beautiful 
visuals using Office 365's 
newest version of Sway
Four visuals to add to your Sway

Communication empowers employees



26A Crash Course in Office 365

1. Make announcements to the group.
The "Announcement" feature is a perfect way to share information 
with a wide range of people at once. By posting an announcement, 
group members will see it in two places: Their Home Feeds and 
Inboxes. 

Three ways to communicate 
across Office 365's internal 
social network

Network administrators can email 
the entire company from the 
All Company group, a default 
aggregation that automatically 
includes everyone.

Communication empowers employees

PRO TIP
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2. Share files with your team.
From Yammer, you can upload a file from your computer or link to 
a Note or file that is already located within the app.

3. Send private messages.
Private messages are delivered straight to the user's inbox.

Communication empowers employees

Avoid duplication by 
choosing the link option for 
files already in Yammer.

Your inbox is a single place 
for you to view, prioritise 
and manage all of your 
messages, conversations and 
announcements, including any 
@mentions.

PRO TIP

PRO TIP
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"With the new meeting and voice 
services, Skype for Business 
Online in Office 365 becomes 
richer and more full-featured. 
It gives us a super-simple 
collaboration environment for 
interacting with one another 
across a globally dispersed 
company. The better we 
communicate, the better we 
perform as a company."

Jason Sele
IT Director, Zetec
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Security is 
a business 
imperative

Chapter 4
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What does it mean to be the most secured 
and confidential Office 365 ever?Whether 
you're a team of five or a Fortune 500, 
enterprise-level security and compliance 
standards are non-negotiable when 
managing your company's data.

Data security matters for every business, 
and it's hard to know if you're implementing 
the measures needed for a strong security 
posture. 

Office 365 helps to keep hackers and viruses 
out of your business and ensures confidential 
data is seen and accessed only by those you 
permit. Office 365's security benefits can be 
divided into three buckets: Compliance, data 
privacy and data security.
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Industry compliance:
Office 365 email adheres to 10 privacy compliance standards in various 
industries, including the requirements specified in the US for the 
medical industry (HIPAA), government and homeland security (DPAS 
& FISMA), education (FERPA) and banking. Microsoft also offers robust 
contractual data privacy and security commitments by default, to help 
customers to comply with local regulations. The Online Services Terms 
contract document includes the EU Model Clauses, UK Data Protection 
Act, and many other provisions, and it applies as soon as customers 
accept the Microsoft licence agreement.

Data privacy and access visibility:
Microsoft's commercial online services do not capture, maintain, 
scan, index, share or use customer data stored or transmitted by 
the service or otherwise use any data-mining technology. The only 
time we touch your data is to provide and maintain the services 
you use. This means that your emails will never be scanned for 
advert-serving purposes, nor will the data you store with us be read 
or unknowingly shared with third parties in any way. In addition to 
Office 365's built-in security features, customers also benefit from 
fully customisable controls that enable them to tailor enterprise-
grade security service to best meet your company needs. For 
example, administrators or help desk staff can receive access to 
a subset of administrative settings appropriate to their roles.

Security against hackers and viruses:
Even if your company has a growing security team, it's nearly 
impossible to assemble a team large enough to uncover and protect 
against the hundreds of possible alerts that come through each day. 
With Office 365, an enterprise-level extension of your security team 
is focused on the physical security of our data centres, the logical 
security level applied to hosted machines and the data security level 
protecting your data through encryption enabled at rest and during 
data transmission.

Security is a business imperative
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Email is the gateway in and out of your organisation. Prioritise 
security across the board with protection against external threats, 
and defend with internal access controls.

• To deal with external threats and unknown risks, Exchange 
Online Advanced Threat Protection comes included with 
Office 365 and helps secure mailboxes against sophisticated 
attacks in real time, eliminating the need to install additional 
virus-scanning software. Every email attachment or link 
that passes through your Exchange server is automatically 
evaluated for suspicious activity, and malicious content is 
neutralised before an attack can occur.

• To protect internal information, Exchange allows your 
administrators to control email access permissions using 
information rights management (IRM) by preventing 
unauthorised people from printing, forwarding or copying 
sensitive information. Data loss prevention (DLP) through 
Office 365 enables administrators to control transport rules, 
actions and exceptions without affecting the email flow.

Security is a business imperative

Eliminate the need 
for virus-scanning 
software
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1. Differentiated access:
Administrators can set policy-based access controls 
based on a user's role in the company, the data access 
location and the sensitivity of the data requested.

2. Unified auditing logs:
Administrators can review file and folder sharing and 
synchronisation histories, based on a shared file's 
owners and users.

3. Sensitive content classification:
SharePoint has more than 80 pre-built definitions of 
sensitive content, and companies can create custom 
policies for their SharePoint sites.

SharePoint lets you and your employees store, access and share files 
on premises (through SharePoint Server) or from outside your office 
(with SharePoint Online). Purchase SharePoint Online as a standalone 
offering or as part of an Office 365 suite and enable the same powerful 
features of SharePoint without the associated overhead of managing 
the infrastructure on your own. With SharePoint Online in the cloud, you 
receive the same best-in-class security and administrative controls and 
provisions that you rely on.

Three important features of SharePoint security

Security is a business imperative

Share files safely and 
easily in the cloud
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Use MDM for Office 365 to secure and 
manage the following types of devices:

Mobile Device Management protects 
a range of Office 365 products, including:

• Android 4 or later versions
• iOS 7.1 or later versions
• Window 8.1
• Windows Phone 8.1

• Windows 8.1 RT
• Windows 10
• Windows 10 Mobile

Security is a business imperative

Smartphones and tablets give your employees the freedom to work from virtually anywhere, but 
what happens if a device loaded with company data is lost or stolen?

Mobile Device Management from Office 365 allows administrators to prevent unauthorised 
user access by setting up policies that ensure that company emails and documents can only 
be accessed on phones and tablets within your Office 365 service. If a device with Office 365 
installed is lost or stolen, administrators can wipe the device clean, regardless of whether it was 
owned by an employee or the company. Furthermore, employee-owned devices can only have 
company information wiped, leaving their personal information intact.

Office 365 mobile 
device management
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"We're making a huge leap 
forwards in our ability to 
support global teamwork, 
without sacrificing security 
and data privacy, by adopting 
the Microsoft Office 365 suite 
of cloud productivity services. 
Office 365 meets both our 
mobility needs and our security 
standards."

Bryan Ackermann,
Senior Vice President and Chief Information Officer, Korn Ferry
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Technology 
drives 
a productive 
workforce

Chapter 5
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Productivity happens when your apps and 
teams are able to work together seamlessly 
and effortlessly. When you're working across 
files and sharing them with the rest of the 
team, you face the risk of losing files or 
experiencing version issues.

As a business leader, you need an organised 
way for you and your employees to edit 
and share files with each other, in order to 
promote greater productivity and efficiency.

From editing in Word to sharing with your 
employees, you'll be able to manage and 
collaborate on shared documents without 
interruption. When all of your tools are talking 
to each other, it makes it easy for you to work 
on projects in real time with your team, from 
virtually anywhere.
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"Tell Me" feature
A text box on the ribbon in Word 2016 reads, "Tell me what you 
want to do." Use this field to enter words and phrases about 
what you want to do next, and quickly navigate to features that 
you want to use or actions that you want to perform.

The top time-saving 
features in Word 
and Excel

You can also use Tell Me to find 
help for what you're looking for or 
to use Smart Lookup to research or 
define the term that you entered.

Technology drives a productive workforce
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One-click forecasting
The forecasting function now enables forecasting based on 
Exponential Smoothing (such as FORECAST.ETS)

On the "Data" tab, click the "Forecast Sheet" button to create 
a forecast visualisation of your data series. 

From the wizard, you can also find options to adjust common 
forecast parameters, such as seasonality, which is automatically 
detected by default and confidence intervals.

Technology drives a productive workforce
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1. Approval workflow.
 Route a document or other item to specified 

team members for approval or rejection.

2. Feedback collection workflow.
 Route documents or other items to 

designated people for feedback, then 
consolidate it all for the workflow owner. 
Then, receive a record of the total review 
process.

3. Signature collection workflow.
 Route the Microsoft Office document 

to designated people for their digital 
signatures.

4. Three-state workflow.
 Track the status of a list item through three 

states or phases. Then, use it to manage 
business processes that require you to keep 
track of a high volume of issues or items.

5. Publishing approval workflow.
 Specifically designed for publishing sites, 

this workflow automates content routing to 
subject matter experts and stakeholders for 
approval and review.

SharePoint workflows are pre-programmed applications that streamline the company's 
processes, from collecting signatures and feedback to tracking employee onboarding status. 
SharePoint workflows bring consistency into organisational procedures. Running a SharePoint 
workflow is easy. Those using it can choose the workflow type that they want, specify the 
options that will work best in the situation and let the workflow take over.

SHAREPOINT WORKFLOWS

Take the guesswork out of 
your enterprise's processes

There are five pre-programmed workflow types:

Document 
arrives

Anna reviews Sean reviews Document 
accepted

Document 
rejected

Document 
routed to 
viewers

Approves Approves

Disapproves Disapproves
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Taking notes on every important part of a meeting can be difficult for 
your employees. How can you ensure that they've captured everything?

No one will miss a thing 
in the next meeting

The notetaker can place their OneNote 2016 notebook in a shared 
location, such as OneDrive or SharePoint.

They can invite others to their shared notebook by selecting 
File > Share > Invite People.

In order for them to share a notebook during a meeting, they can 
choose File > Share > Share with Meeting. 

After others have opened the notebook, anyone with permissions 
can add meeting notes, all at the same time. OneNote syncs 
automatically, and everyone's notes appear.
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Insights 
unleash 
the power 
of data

Chapter 6
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From customer-generated data to the data 
on how your employees work, information 
surrounds your business. Within it are insights 
waiting to be discovered and harnessed to 
transform your business and your bottom line.

With Microsoft Office 365's insight-centric 
apps, your employees can analyse, then 
visualise data in beautiful presentations and 
compelling visuals that can then be shared 
amongst your teams.
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Gather results in 15 seconds or less.
A single set of data is all you need to begin using Power BI. From the "Data Sets" 
section in the left pane, select the ellipses that you're interested in analysing. 
From the menu of options, select "Quick Insights". After a mere 15 seconds, your 
insights will be ready. Click "View insights". From there, you can interact with 
your insights in the following ways:

• Pin visuals to a dashboard

• Filter for additional insights.

Ask questions to glean insights.
Power BI is equipped with a powerful language recognition engine that will 
generate reports and visualisations from specific questions that you ask. 

• Start in the dashboard for the data set that you want to analyse.

• Enter a question using natural, conversational language (e.g. "What was 
our revenue in 2015?"). A list of suggested terms will appear based on your 
question.

• Click on a term to see results and a corresponding visual.

• Save the visual to the dashboard by selecting the pin icon next to the 
question input box.

The potential of 
a single database

Power BI
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Collect your insights in a dashboard.
It only takes one pinned visual to create a dashboard. Once 
you've started to build a dashboard full of insights around 
a particular data set, you can rearrange the layout. 

• Resize a tile by dragging its handles in or out.

• Move a tile by simply clicking and dragging it to where 
you want it to be in your dashboard.

• Change the title or subtitle by hovering over a tile, 
clicking on the pencil icon and opening the tile's details.

Insights unleash the power of data
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MICROSOFT MYANALYTICS

Personal insights 
help employees to 
work smarter

Insights unleash the power of data

Using Microsoft MyAnalytics, 
employees can see how they're 
spending time across four areas:

• Which individuals do you interact with the most?
• How quickly do you respond to their emails?

• How quickly do you read and respond to your emails?
• What are your average email reading rates and response times?

• How often have you had at least two hours to focus?
• How can you find more time to focus?

• How many hours have you spent in meetings this week?
• How effective are they?

Emails

Focus Hours 

Meetings

Network
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Scaling for success starts with the 
right business apps to get the work 
done. Better work is truly possible if 
you equip your business with apps 
that promote mobility, collaboration, 
communication, security, productivity 
and insights.

Now that you understand what 
various Office 365 products can do 
for your organisation, it's time to: 
Take a Guided Tour 

http://go.microsoft.com/fwlink/p/?LinkID=715763

